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Introduction 
  

0.0  Overview 
 

This case study is intended to provide the new user with a quick 
introduction to the use of VAPOR (Visualization and Analysis Platform for 
Research) with WRF (Weather Research Forecast model), visualizing data 
obtained from the advanced research WRF ARW model. 
   

This case study is provided as a self-guided tutorial showing how to use 
the most important features of VAPOR on a weather dataset.  The methods 
presented here are applicable to other datasets as well.  
 

The results of numerical simulation are best understood when users 
interact directly with the data.  This principle is central to the design of VAPOR.  
Users should be able to instantly see three-dimensional visualizations of the data 
as they tweak the parameters defining the visualizations.  This iterative data 
exploration process enhances understanding of the features of interest in the 
data. 

 
To ensure interactive visualization, VAPOR relies on the latest available 

graphics technology, i.e. graphics cards available at low cost in current personal 
computers.  In addition, VAPOR supports interactive access to massive datasets, 
by allowing users to select the data resolution and region of interest to visualize. 

 
This case study applies VAPOR to visualize a frost event (scenario) that 

occurred in the southeastern U.S. between April 4 and April 11, 2007. This frost 
event contributed to $257.5 million losses due to damages to newly emerging 
crops.  The data are the result of a case study funded through a partnership with 
the U.S. Department of Agriculture-Risk Management Agency, and performed by 
Thara Prabhakaran and Gerrit Hoogenboom of the University of Georgia. The 
WRF ARW model was evaluated for frost assessment using data from the 
Georgia Automated Environmental Monitoring Network (AEMN) 
(http://www.georgiaweather.net).   
 
 Many of the capabilities of VAPOR are illustrated in the Vapor Quick Start 
Guide (http://www.vapor.ucar.edu/sites/default/files/docs/QuickstartGuide.pdf).  
You may want to work through that guide as well as this case study. The VAPOR 
Quick Start Guide explores turbulence data on a uniform grid.  The visualization 
techniques performed there can also be applied to WRF data.   
 

0.1 Update for VAPOR Version 1.5 
 
This version of the case study has been updated to include new 

capabilities introduced in VAPOR since version 1.2.  These include: 
 

http://www.georgiaweather.net/
http://www.vapor.ucar.edu/sites/default/files/docs/QuickstartGuide.pdf
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 Image display (discussed in section 1.3) 

 Animation toolbar (discussed in section 1.6) 

 User preferences (discussed in section 1.1) 

 Spin animation (section 1.2) 

 Color mapping of variables to isosurfaces (section 1.7) 

 Support for two-dimensional variables (section 3) 

 Extension of variables below/above WRF grid (section 4.2) 

 Image-based flow visualization (section 4.3) 
 

0.2 Setting up for performing this case study 
 
Before you begin, you need to have access to a (Linux, Windows, Mac or Irix) 
workstation on which VAPOR has been installed.  Follow the installation 
instructions provided on the VAPOR website (http://www.vapor.ucar.edu).  When 
you run VAPOR, you need to be directly connected to the graphics console of the 
system.  You cannot run VAPOR via a remote (ssh) shell, however you may be 
able to remotely connect to a graphics system via a remote graphics server such 
as VirtualGL, IBM‟s RVN, or HP‟s RGS.  
 

You will need to prepare your execution environment before running 
VAPOR.  For Unix and Macintosh users, there are shell scripts in the bin 
subdirectory of the VAPOR installation directory.  You will need to initialize your 
shell by sourcing vapor-setup.csh (in a C shell) or vapor-setup.sh (in a Bourne 
shell).  Remember to re-source these whenever you change your shell.  
Windows users need to run the VAPOR installers to set up the required paths.  
After VAPOR is installed, the environment variable VAPOR_SHARE will be set a 
directory name where are installed examples, documents and other files that will 
be useful. 
 

Prior to working through this case study, you will need to download and 
install an example WRF dataset from 

 http://www.vapor.ucar.edu/page/vapor-download#Example.   
The data is entitled “april_lowres”, because this is a low-resolution version of the 
original data. The data resulted from WRF simulation by Thara Prabhakaran and 
Gerrit Hoogenboom at the University of Georgia, of a weather pattern occurring 
between April 4, 2007 and April 11, 2007.  This constituted a cold front followed 
by persistent cold air mass over Georgia and the retrieval of the cold air mass, 
that was replaced by warm moist air from the south.  There are 180 time steps, 
one time step per hour, in these datasets.  In the april_lowres dataset, all 180 
time steps of the data are available at the lowest refinement level (0), which is ¼ 
the resolution of the original data in each dimension.  The april_lowres data also 
includes 1/10 of the time steps at refinement level 1, i.e. includes refinement level 
1 data at 10 hour intervals.   The original dataset was calculated at refinement 
level 2, on a grid with horizontal spacing 9km.  We have not provided the highest 
refinement level because it is too big to easily download.   

 

http://www.vapor.ucar.edu/
http://www.vapor.ucar.edu/page/vapor-download#Example
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Note that any scientific conclusions obtained by visualizing low resolution 
data should be confirmed by visualizing the appropriate portions of the data at full 
resolution.  Contact Thara Prabhakaran (thara@uga.edu) to obtain access to the 
original data. To see how this data was converted from the original WRF dataset, 
refer to the VAPOR/WRF Data and Image Preparation Guide (available at 
http://www.vapor.ucar.edu/page/wrf-support). 
 

0.3  Using sample sessions in this case study 
 
If you encounter problems following all the steps in this case study, or if you just 
want to jump to a specific example visualization, you can quickly advance to any 
of the tasks below.  For all of the illustrations in this case study, there is a 
VAPOR session file named “WRFFigureA.B.vss”, that can be used to initialize 
VAPOR into the same state as was used to generate Figure „A.B‟ below.   The 
session files are available for download from the VAPOR download page 
(https://www.vapor.ucar.edu/page/vapor-download#Example). These are also 
installed in the VAPOR examples directory, which is the subdirectory 
$(VAPOR_SHARE)/examples/ in the VAPOR installation. To make use of a 
session file, say for figure “A.B” (A and B being integers), perform the following: 
 
1. From the VAPOR File menu, click on Open Session and select the desired 

session file “WRFFigureA.B.vss” in this document.   
2. From the VAPOR Data menu, click on: Load Data into current Session and 

select the metadata (vdf file) associated with that figure (april_lowres.vdf). 
3. Click on the various renderer tab(s) used in the illustration (DVR, Flow, Iso, 

2D, Image, or Probe).  For each tab, under the heading Renderer Control, 
click the check-box for each renderer instance that that is used in the figure. 

4. If the illustration includes an image, such as a terrain image, you may need to 
respecify the file path where the image is located on your system.  In the 
image tab, click the button “Select Image File” and then select the appropriate 
image file. 

5. If there is a mouse mode that is used in the illustration, (e.g. “Region Select”, 
“Navigation”, “Data Probe”, “Rake” or “2D”) you should select the appropriate 
mode by clicking on one of the mode select buttons below the VAPOR main 
menu bar. 

 
You should see a similar image on your screen as is shown in figure “A.B” in this 
document. 
 

mailto:thara@uga.edu
http://www.vapor.ucar.edu/page/wrf-support
http://www.vapor.ucar.edu/page/wrf-support
https://www.vapor.ucar.edu/page/vapor-download#Example
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Section 1:  Visualizing a Cold Air Mass with Isosurfaces 
 

1.0 Launching VAPOR 
From the command line issue the command “vaporgui”.  (In Windows or Mac, 
you can double-click on the “vaporgui” icon on the desktop, or type “vaporgui” 
from a console window.) You should see a screen like the following: 
 

 
Figure 1.1:  Initial VAPOR GUI window 

 
The right side of this screen (mostly black) is the “visualizer window”, where the 
3D graphics images are displayed.  The left side of the screen has a set of tabs 
across the top, labeled View, Animation, Region, 2D, Image, Probe, Iso, Flow, 
and DVR.  In this section we shall show how to use the Image panel, Iso 
(isosurface) panel and the DVR panel (this stands for “direct volume rendering”, 
referring to the fact that this panel controls the direct conversion of data to a 
volumetric representation.) 
 

1.1 User preference settings 
 

Before loading a data set, it is useful to set up your user preferences, 
which are settings that apply just to your individual system and usage 
requirements.  Most of the defaults will work fine; however, one important 
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preference that you may want to change is the data cache size.  You will get the 
best performance from VAPOR if the cache size is about equal to the physical 
memory available to you on the computer you are using.  To set this preference, 
click on Edit→Edit User Preferences, and you will see the user preferences panel 
shown in figure 1.2. Set the Cache Size (Megabytes) to a value appropriate to 
the computer you are using. 
 Another preference setting that will be useful is to allow VAPOR to use 
lower resolution data when the higher resolution is not available.  This setting is 
particularly useful with the april_lowres dataset, because the available refinement 
level depends on the time step you are viewing.  The higher level is only 
available at time steps that are multiples of 10.   So, check the box labeled 
“When data is missing, use lower refinement level if available”.  After making 
these settings, click “OK”, and then save the preferences to its default location 
(usually the $HOME directory), so that these settings will be available the next 
time you run VAPOR from the system you are using.  These settings are not 
affected by loading session files. 
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Figure 1.2:  User Preferences Panel 

 
 

1.2  Some useful help features 
 
Tooltips and context-sensitive help.  You can quickly answer questions about 
things you see in the VAPOR user interface, using either “tool-tips” or “context-
sensitive-help”.  If you hold the mouse over a button, text-box or other widget for 
a few seconds, a tool-tip will appear, giving a one-sentence explanation of the 
widget.  If you need a deeper technical explanation, click on the Help menu at the 
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top of the screen, then click on the menu item labeled “? Explain This”.  Then 
click on the item you are curious about.  A yellow context-sensitive help box will 
appear such as shown below: 
 

 
Figure 1.3:  Context-Sensitive Help 

 
Mouse Modes.  To assist you in accessing visual features in the 3D scene, 
VAPOR has six mouse mode buttons above the tabs at the top-left of the 
window: 
 

 
 

Clicking on these buttons enables you to manipulate the size and location of a 
shape being visualized in the scene.  From left to right, these buttons are 
associated with the following manipulation modes: 
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1. Navigation mode, used to rotate, zoom and translate the viewer position in 
the scene.  Spin animation is also available in navigation mode.  (Note:  
mouse-based navigation is also available in the other modes as well, 
provided the mouse is not depressed over one of the box handles in the 
scene). 

2. Region mode, used to manipulate the box-shaped region which is used for 
volume rendering, isosurfaces, and flow integration. 

3. Rake mode, used to specify a “rake” box, controlling the position of flow 
seed points. 

4. Probe/contour mode, used to control the location and size of the 
probe/contour plane tool. 

5. 2D mode, used to position a plane of two-dimensional data in the scene. 
6. Image mode, used to control the location and size of an image placed in 

the scene. 
 

1.3  Specifying a volume dataset and a terrain image 
 
Click the Data menu (at the top of the screen) and you will see a list of various 
commands that can be applied to datasets. Click “Load a Dataset into current 
session”.  (You can alternatively load a dataset into default session, at this point).  
You will see a file selection dialog, asking you to “Choose the metadata file to 
load into current session”: 
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Figure 1.4:  Loading a metadata file 

 
This file selection dialog enables you to read a file of type “.vdf”, which stands for 
“Vapor Data Format”.  These are Metadata files, not data files:  .vdf files contain 
descriptions of data.  Typically the referenced data is in many different files. 
  

Choose the file “april_lowres.vdf” and click “Open”.   This is a time-varying 
WRF data set.  It contains a vector field consisting of the three components (U, 
V, W) of the wind velocity, as well as perturbation potential temperature (T), 
water vapor mixing ratio (QVAPOR), cloud water mixing ratio (QCLOUD) and an 
auxiliary variable (ELEVATION) indicating height in meters above sea level found 
from (PH+PHB)/9.81; where PH and PHB are perturbation and base state 
geopotential height.  There are also a few two-dimensional variables, such as 
HGT (height above sea level), TC (temperature at ground level), T2 (temperature 
at 2 m), TD (dew point temperature at ground level), U10 and V10 (wind at 10m), 
SLP (sea level pressure), and TH2 (temperature at 2m above terrain).  The 
variables HGT, T2, U10, V10, and TH2 result from the WRF-ARW simulation, 
and the other 2D variables (SLP, TD, TC) were derived using NCL and added to 
this Vapor dataset.  Instructions for including derived variables are given in the 
VAPOR/WRF Data and Image Preparation Guide document. 

 
You will see a white rectangle in the visualize window as the following: 

http://www.vapor.ucar.edu/page/wrf-support
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Figure 1.5: Bounds of april_lowres data 

 
 The rectangle is actually the top view of a slab shaped region enclosing 

the data.  This data volume is very flat, about 1000 km in each of the two 
horizontal dimensions, and about 1.6 km high.  In order to effectively visualize 
this data we need to stretch this volume in the vertical direction, exaggerating the 
height.  Click on Edit → Edit Visualizer Features.  You will see following panel: 
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Figure 1.6: Visualizer Feature Selection panel 

 
This panel allows setting various properties of the visualizers.  Note the 

three text boxes labeled “Scene Stretch Factors X, Y, Z:”. Set the third (Z) stretch 
factor to 100.  Click “Apply” and you will see that the data volume has stretched 
vertically.   
 There are a number of other capabilities controlled by the visualizer 
features panel that you may find useful; for example providing coordinate axis 
annotation and time annotation.  The visualizer feature panel also supports 
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display of the terrain surface.  However, it is best to use Image tab for viewing 
images on the terrain; which we shall describe next. 
 
Click on the Image tab to see the following panel: 
 

 
Figure 1.7:  Image panel (top) 
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We shall use the image panel to place a satellite image of Georgia in this scene. 
Click on the button labeled Select Image File  and select the file 

“georgia_satview.tif” which is located in the same directory as the 
april_lowres.vdf file you loaded previously.  This image is a geoTiff file (geo-
referenced tiff file), an image with additional information that enables it to be 
positioned correctly in world coordinates.  Instructions for obtaining such images 
are provided in the VAPOR/WRF Data and Image Preparation Guide .  This 
image was enhanced with the political boundaries of Georgia and the location of 
Atlanta by Thara Prabharan.   Check the box “Apply image to terrain” in the 
Image panel.  Then, near the top of the image panel, check the checkbox next to 
“Instance:1” to enable display of the image.  You should see the following in the 
visualizer: 

 

 
 

Figure 1.8: View of terrain from above 
 

http://www.vapor.ucar.edu/page/wrf-support
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The coloring of the surface is based on a satellite image of the region, with 
additional lines added to indicate boundaries of counties in Georgia.  There is a 
white dot at the location of Atlanta. Note that this image is not exactly square, for 
it extends beyond the WRF domain along the south-west and south-east 
boundaries.  This is because the satellite image uses a latitude/longitude 
rectangle, whereas the WRF domain is a rectangle in the Lambert conformal 
conic map projection.   You can crop the image to the WRF domain by checking 
the “Crop to bounds” checkbox in the Image panel. 
 

Click and drag your left mouse in the right window and you will rotate the 
image you are viewing. Note that if you release the left mouse button while you 
are still rotating then the scene will continue to spin.  You can stop the spinning 
by clicking in the scene.  This spin animation only occurs in navigation mode; i.e. 
only when the navigation wheel at the upper left-hand corner of the window is 
depressed. 

When you click and drag the right mouse button vertically, you zoom into 
or out of the scene.  If you click and drag the middle mouse button, you translate 
the image vertically or horizontally.  Now drag the mouse upward in the scene so 
you can view the region from the south, and the mountain range in northern 
Georgia will stand out.  (Note that the scene has been exaggerated vertically by 
a factor of 100).  Set your viewpoint so you are looking approximately from the 
south to the north. Then, select “Nearest Axis” from the “Align View” combo box, 
at the top right of the VAPOR window.  You see the following: 
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Figure 1.9: Vertically stretched region above Georgia, from the south 

 
This figure shows the full domain with a vertical extent of 16 km. We are 

mostly interested in the weather near the terrain surface, so we shall restrict our 
attention to the bottom 1/10th of the volume.  Click on the cube symbol near the 
top left of your screen, on the button identified in its tool-tip as Region Select 
Mode.  You will see that the volume in the scene becomes enclosed by red lines, 
with cube-shaped handles on each side.  These handles can be used to 
manipulate the bounds of the region that we visualize. If you „grab‟ a handle by 
clicking on it with the left mouse, you can slide the whole region in the direction of 
the handle.  If you „grab‟ and slide with the right mouse button, you will slide only 
the side of the region closest to the handle.  You are initially prevented from 
sliding with the left mouse button because the region is the entire domain and 
you cannot move the region bounds outside of the full data domain. 
 
 Click with the right mouse button on the handle at the top of the cube.  
The handle will change color to yellow. Drag it downward until the red box is 
about 1/10 of the full height of the original domain, (about 3200 m).  Then release 
the mouse.  Note that you can also read the height of the region in the Region 
panel, specified as the “Z-size”. To get a closer view, click on the magnifying-
glass near the upper right corner of the window.  Navigate in the scene using the 
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left and right mouse buttons to get a good view of Georgia from the south.  You 
will see something like the following: 
 

 
Figure 1.10: View of selected region near the ground with box handles  

 
1.4  VAPOR Renderers and Renderer Control 

 
The “Instance:1” checkbox that you used to enable rendering of the terrain 

image is a device that you will see in many other tabs. DVR, Flow, Iso, 2D, 
Image, and Probe tabs control the rendering of images in the visualizers. Each of 
these tabs has a Renderer Control section near the top, appearing as follows: 
 

 
Figure 1.11: Renderer Control 

 
Using the Renderer Control, you can control any number of renderers in the 
current visualizer, after you have loaded a dataset.  The different renderers are 
identified as “Instance: 1”, “Instance: 2”, etc.  When you click in the check-box, 
the specified renderer is enabled; i.e. the renderer will start drawing in the current 
visualizer.  One of the renderers is active, in the sense that the parameters 
displayed in the current tab, below the Renderer Control, apply to that renderer.  
The active renderer instance is indicated by boldface text on “Instance: N” button, 
and it appears depressed relative to adjacent instance buttons.   When there are 
multiple instances, you can change the active renderer by clicking on the 
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Instance: button. Additional renderers can be created by using the “New” button 
or the “Duplicate In” selector.   The “Duplicate In” selector constructs a duplicate 
of the renderer in the current visualizer, or in any other visualizer window (when 
multiple visualizers are available).  Multiple Flow, Iso, Image, 2D, and Probe 
renderers can be enabled at the same time in the same visualizer.  However, 
only one DVR renderer can be enabled at one time, because of limitations in 
hardware support for volume rendering. 
 

 
1.5 Constructing an isosurface of the temperature 

 
Click on the Iso tab to specify the parameters of an isosurface.  In order to 
construct an isosurface of T, it is useful to first check the values of the variable T 
in the current region.  From the “Variable” selector, pick the variable T.  Note the 
black rectangle in the Iso tab: This is the histogram window (see figure 1.12), 
where histograms of the iso variable are displayed.  Below the histogram 
window, to the left and right of the descriptor “Data Bounds” are values -7.59491 
and 101.12110. 
 

The Isosurface Value textbox indicates the value of the variable T for the 
displayed isosurface. Type in an Isosurface Value of -10.  The data bounds 
below the Isosurface Selection window indicate the min and max value of the T 
variable at the first time step.  Type the values -30 and 10 in the left and right 
“Histo Domain Bounds” immediately above the Data Bounds, specifying an 
interval of values of T that will be useful for observing the cold air mass.  Press 
enter to set these values, then click the buttons “Fit to View” and “Histo” above 
the histogram window.  You will see a histogram as shown below: 
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Figure 1.12: Isovalue selection window 

 
You may note that there is a peak in the histogram at 10.  This is because all 
values of T that are above 10 are shown at the largest value in the histogram.   
 
 Near the top-left of the Iso tab, under the heading “Renderer Control” 
there is a check-box, identified as “Instance 1:” Click in this check-box to enable 
an isosurface rendering.  You will not see an isosurface because, as indicated in 
the histogram, all the values of T are greater than -10.  Type in the value -1 as 
the Isosurface value (below the histogram window).  You can also set the 
isosurface value by grabbing the isovalue slider (the red double-arrow at the 
bottom of the histogram) with the left mouse, and sliding it to about -1. You will 
then see the following isosurface of the variable T:  
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Figure 1.13: Isosurface rendering with T = -1 

 
[Note:  On some systems with older or less capable graphics cards you may 
experience problems with isosurface rendering.  If so, bypass the remainder of 
this section.  You can instead visualize the cold air mass using the DVR 
renderer.  Instructions for rendering T with the DVR are given at the end of 
Section 2.] 
 

Grab the slider at the bottom of the histogram window and slide it to the 
right or left, to get an idea of how the isosurfaces vary with T.   
 

1.6  Animating the isosurface 
 
Time steps and animation can be controlled in the Animation tab, or by using the 
animation toolbar.  The animation toolbar, at the top of the VAPOR main window, 
provides a set of VCR controls and a text window as follows: 
 

 
Figure 1.14: the Animation Toolbar 
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The animation toolbar controls the time-stepping in the current active visualizer 
window.  It contains the most useful functions of the Animation tab. 
 
Select an isovalue of about -18, and then click on the Animation tab.  Click the 
right-pointing triangle (►) to play forward in time.  You will see that, starting at 
about frame 25, the cold air mass advances over the mountains at night, then 
recedes during the day, then advances and recedes several more times, 
indicating diurnal changes.   
 

You may note that the isosurface is somewhat rough.  There are several 
things that can be done to improve the visual quality: 
 

 Change the Bits per voxel (at the bottom of the Iso panel) to 16.  This will 
make the surface appear much smoother. 
 Reduce the Constant Opacity to a value of 0.9, so that you can see the 
terrain under the isosurface.  The opacity is set in a text box on the right side 
of the bottom “Isosurface Appearance” section of the isosurface panel. 
 In the Region panel, increase the “Full Vertical (Z) Grid Size” to 400. This 
will result in a more accurate interpolation of the data near the terrain 
boundary. 
 Change the Refinement level to 1 (using the selector near the top of the 
isosurface panel, resulting in more accurate isosurfacing).  This will improve 
the visualization of those time step values that are divisible by 10.  Because 
of the earlier setting in the preferences panel in section 1.1, when you try to 
visualize other timesteps at refinement level 1, VAPOR will automatically 
revert to refinement level 0, because refinement level 1 is not available.  If 
you did not set the user preferences, then whenever you look at times not 
divisible by 10, you will see a message indicating that the data for T is not 
available at the requested refinement level. 

 
 
The above changes may make the rendering slower, so you may want to 
postpone such changes until you are ready to produce your final images.  The 
following illustrates the isosurface at time step 50, after making the above 
changes: 
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Figure 1.16:  Isosurface of T = -18 at time step 50 

 
Some features of the approaching and receding cold air mass can be easily seen 
by animating the isosurface. For example, observe the isosurface between time 
steps 140 and 155.  You will observe that as the air mass recedes, the cold air 
“pools” in the valleys.  You may also note that the vicinity of Atlanta is relatively 
warmer than the surrounding areas.   
 

To take a closer look, stop the animation at time step 150.  On the Iso 
panel, set the Refinement level to 1, and set the iso value to -20.  From the 
Image panel, set the refinement level to 1.  By dragging with the right mouse, 
zoom into the scene to see an image like figure 1.16 below: 
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Figure 1.16: Pooling of cold air at time step 150 

 
1.7:  Mapping color and opacity onto an isosurface 
 
A feature of VAPOR, introduced in version1.3, is the capability to color an 

isosurface based on the values of another variable.  We shall illustrate this 
capability by coloring the isosurface of T based on the values of the variable 
QVAPOR. 

 
Disable the isosurface rendering by un-checking the “Instance: 1” 

checkbox.  Scroll down to the bottom of the Iso panel. In the section labeled 
“Isosurface Appearance”, using the “Mapped Variable” selector, pick the variable 
“QVAPOR”.   There is also a section labeled “Transfer Function Editor” in which 
the variable “QVAPOR” is now identified in red text.  The transfer function 
determines is a mapping of QVAPOR to color and opacity that will be applied to 
the isosurface.   

 
We shall alter the color mapping, reversing the direction of the color scale 

so that larger values of the variable are associated with red, smaller values with 
blue-violet.  Click on the button “Load Installed TF” and then select the file 
“reversedOpaque.vtf” and click “Open”.   Note that the opacity mapping (by 
default) is the constant 1, indicated by the horizontal green line across the top of 
the transfer function window.  Click on the “Histo” button above the transfer 
function mapping window to show a histogram of the values of QVAPOR in the 
current region.   
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Now scroll up to the top of the Iso tab and enable the isosurface by 

checking the “Instance: 1” checkbox.  You will see that the isosurface is colored 
mostly blue and blue-violet indicating the values of QVAPOR on the isosurface 
are mostly in the range (0, 0.006), as follows: 

 

 
Figure 1.17: Isosurface of T colored according to values of QVAPOR 

 
Next we modify the transfer function to provide a more interesting 

mapping, using both transparency and color mapping.  On the Animation tab, set 
the current time step to 130.  Returning to the transfer function editor at the 
bottom of the Iso tab, click on the Histo button to see the values of QVAPOR in 
the current region at time step 130. Below the histogram window, type in the 
values 0.001 and 0.005 as the left and right TF Domain Bounds, then click “Fit to 
View” and “Histo” to see a histogram based on the new domain you set.  To de-
emphasize the lower values of QVAPOR, click on each of the two leftmost points 
on the green line across the top of the transfer function window, and drag them 
about ¼ of the way downward (as shown below).  This will cause the 
corresponding values of the QVAPOR variable to map to smaller opacities, 
making the isosurface partially transparent at lower values of QVAPOR.  The 
resulting image is shown below, emphasizing the part of the isosurface where 
QVAPOR is largest: 
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Figure 1.18: Color and opacity mapped to emphasize features on isosurface at 

time step 130 
 

 You may find it interesting to animate this isosurface between time steps 
130 and 150, to see the evolution of the cold air with higher QVAPOR values, or 
to experiment with different mappings of color and opacity.  Before proceeding to 
the next section, disable the color mapping of QVAPOR by setting the Mapped 
Variable back to “constant”.  
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Section 2:  Volume Rendering of QVAPOR and T 
 

2.0 Setting up for volume rendering 
 

We shall next do a volume rendering of the “QVAPOR” variable. This is 
useful for visualizing the cold front that precedes the advance of the cold air 
mass.  This volume rendering can also be used to see the presence of moist air, 
moving northward from the Gulf of Mexico when the cold air retreats.   We shall 
rely on the setup that we prepared in Section 1.  If you are beginning at this point, 
you can load the session file for figure 1.17 and load the dataset and satellite 
image as in section 1.3.   Enable the terrain image by checking the “Instance:1” 
checkbox in the Image panel.  Proceed as follows: 

 
 Make sure the isosurface is disabled, by un-checking the checkbox in the 

instance selector at the top-left of the Iso tab.  On the animation tab, set the 
current timestep to 0.  Then, click on the DVR tab. On the upper-right side of the 
DVR tab there is a “Variable” selector.  Select the variable “QVAPOR” from the 
list.  Near the top-left of the DVR tab, check the first renderer instance, identified 
as “Instance 1:” to enable a volume rendering.  Click on the magnifying glass 
(near the upper right corner of the window) to view the current region of data. 
You will see the following: 

 

 
Figure 2.1:  Volume rendering of QVAPOR 
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The image on the right is a 3D volume rendering of the variable „QVAPOR‟ from 
the data set.  The colors are based on a default color mapping, showing the 
variations of the QVAPOR variable from its lowest value (red) to the highest 
value (violet). 

 
  

2.1 Designing a transfer function 
 
The appearance (i.e. color and transparency) of the volume rendering is 
controlled by the Transfer Function Editor in the middle of the DVR panel, as 
shown below: 

 
 

 
Figure 2.2:  The VAPOR Transfer Function Editor 

 
The transfer function enables visualization of important values of a variable, by 
making the volume opaque at the important values and transparent elsewhere.  It 
also can be used to visualize the placement of different values of a variable by 
assigning various colors to these values.   
 

We shall edit the transfer function to highlight the larger values of the 
QVAPOR variable, so we can see more clearly the motion of moist air. In the 
center of the transfer function editor window there is a blue-green histogram, 
indicating the values of the variable „QVAPOR‟.  You can make values of the 
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variable less prominent by making them more transparent, and different non-
transparent values can be distinguished by applying different colors to them. 

 
 The transfer function editor enables you to define a mapping from data 
values (in this case, values of the variable “QVAPOR”) to both color and opacity.  
The color is controlled by a horizontal bar of colors at the bottom of the editor.  
Opacity is controlled by the green line in the center region. You initially will see 
four color control points (grey triangle pairs) on the color bar, and four opacity 
control points (grey squares) on a diagonal green line.  Colors and opacity in the 
scene are interpolated between the control points.   
 

We must make some changes in the domain of the transfer function, to 
focus our attention on larger values of QVAPOR.  Note that the domain is initially 
set to (2.279e-06, 0.0172).  This is the range of the variable QVAPOR at the first 
time step.  Grab the left end of the red arrow at the top of the transfer function 
window, and slide it to the right, about 2/3 of the way across the TF window, 
Then, above the histogram window click on the button “Fit to View” and on the 
“Histo” button. The editor should appear as follows:  
 

 
Figure 2.3: Transfer Function Editor with higher QVAPOR values mapped to 

increased opacity. 
 
Next we make some changes in the opacity curve, to show some important 
values of the variable „QVAPOR‟.  We are interested in the higher values of 
QVAPOR, as they indicate presence of water vapor.  To show these values we 
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make the opacity lower for smaller values of QVAPOR.  We will make the opacity 
curve in the transfer function editor look like the curve you see in Figure 2.4 
below.   
 

You move control points by clicking on them with the left mouse button 
and dragging them to their new locations.  You create new control points by 
clicking with the right mouse at the desired location, and then selecting “New 
Opacity Control Point” from the menu of choices. 

 
First select the second opacity control point from the left, and drag it down 

almost to the bottom of the opacity graph, setting the opacity to about 0.10.  Drag 
the third opacity control point from the left downward to an opacity of about 0.30.  
(You can see the current opacity value by holding the mouse over the point, and 
you can set the value by clicking the right mouse button over the control point.)  
Leave the fourth (rightmost) opacity control point alone, so that values of 
QVAPOR greater than or equal to 0.017 will always be opaque  If you make 
mistakes, you can undo (or redo) your latest changes by selecting “Edit” from the 
main menu, and clicking to undo (or redo) the specified actions.   Note that you 
can also adjust the overall opacity with the vertical slider to the right of the 
opacity window.   

 
It will also improve the visualization to change the colors.  A yellow color 

can be used to indicate increased moisture. With the right mouse button, click on 
the left color control point (at the left end of the color bar).  Select the “Edit 
control point” option. From the menu that results, select white, for example 
choose (R,G,B) to be (255,255,255).  Assign colors to other control points using 
increasing levels of yellow, such as shown below.  (You can also select colors by 
selecting the color control point and then picking a color in the color selector 
above the transfer function editor).   

 
Animate the scene from frames 10 to 40.  Note that a band of moist air 

moves from north to south across Georgia.  These are the cloud bands ahead of 
the cold front we are looking for.   Adjust the slider on the right of the transfer 
function editor window up and down, to make the moist air transparent enough to 
see it the terrain. 

 
Zoom into the scene by dragging the mouse upward in the scene with the 

right mouse button depressed. Your transfer function and visualizer should look 
about like the following: 
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Figure 2.4: DVR of QVAPOR with edited colors and opacities  

in the Transfer Function at time step 10. 
 
 
2.2 Animating the humidity and temperature 

 
To track the motion of the cold front, use the animation toolbar.  Click the right-
pointing triangle (►) button to play forward in time.  If it plays too fast, reduce the 
Max Frames/Second value.  You will see the cold front pass in the first 40 time 
steps.  Later, starting at frames 140 or so, moist air returns from the south as the 
cold air dissipates.  Click on the Iso tab, and enable the isosurface rendering that 
we created in Section 1.  You can see how the advancing cold air mass follows 
the cold front, and recedes later.  The following image (Figure 2.5) shows this 
animation at time step 31, when the cold and dry air mass flows over Georgia 
and the moist air is located farther south, gradually disappearing from the 
domain. 
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Figure 2.5: At time step 31 the cold front, identified by a volume-rendered band of 

moist air, is followed by the cold air mass. 
 

2.3 Other volume visualizations  
 
Other variables in this WRF dataset, such as QCLOUD or T can be understood 
using volume visualization.  For example, the cold air mass that we tracked (in 
Section 1) using an isosurface, can also be seen using a volume visualization. 
Disable the isosurface rendering, by un-checking the “Instance:1” checkbox in 
the Iso panel. From the DVR panel, change the selected variable from QVAPOR 
to T.   In the animation toolbar, set the current time step to 31, where we know 
the cold air advance will be visible. 
 

Recall that we found the isosurface T = -18 to be useful in tracking the 
cold air mass.  We can use the transfer function editor to construct an opacity 
mapping, using a Gaussian curve centered at -18.  Click with the right mouse 
button over any of the opacity control points in the transfer function editor.  You 
will see a menu of choices of actions that can be applied at that control point.  
Select “Delete Opacity Widget”.  Then, click again with the right mouse button in 
the middle of the opacity edit region.  Select “New Opacity Widget → Gaussian”.  
You will see a gaussian curve filling the opacity region.  Type in -21 and -15 as 
the left and right TF Domain Bounds, and then click on “Fit To View”, to center 
the Gaussian curve in the opacity window.  Click with the left mouse button on 
the Gaussian curve, to select it.  You will see a red square on the left end of the 
Gaussian curve, and a green square in the middle.  These are handles that can 
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be used to modify the curve.  Slide the red square down, narrowing the Gaussian 
curve, to obtain a curve that is concentrated mostly in the center third of the 
opacity region, as shown below: 

 

 
Figure 2.6:  Using a Gaussian curve to define a transfer function for T, with 

opacity concentrated at T = -18. 
 
Using the Color Selector above the Transfer Function Editor, make all four color 
control points a light grey (e.g. R = G = B = 195).   Grab the opacity control slider 
on the right side of the opacity edit window and pull it about 1/3 of the way down.  
You should see an image similar to the isosurface we saw before.  Compare 
figure 1.16 to the resulting volume rendering at timestep 50: 
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Figure 2.7:  Volume rendering of T at time step 50, 

with grey colors and reduced opacity. 
 
We leave it as an exercise for the user to construct a volume rendering of 
QCLOUD that illustrates the development and motion of clouds in this dataset.
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Section 3: Visualizing Two-dimensional Variables  
 
 3.0: Two-dimensional Data 
 

VAPOR includes the capability of visualizing two-dimensional variables.  
They must be horizontally oriented (a function of the X and Y coordinates in the 
scene).  These can be displayed on a horizontal plane or can be applied to the 
terrain in the scene.  In this section we provide a brief introduction to this 
capability. 

The april_lowres dataset includes several two-dimensional variables.  Five 
of them were output by the WRF-ARW simulation:  HGT (height above sea level), 
T2 (temperature at 2 meters), TH2 (potential temperature at 2 m), and U10 and 
V10 (wind at 10m). There are also three variables that were calculated using 
NCL scripts (see  
http://www.mmm.ucar.edu/wrf/OnLineTutorial/Graphics/NCL/index.html ).  
These derived variables include SLP (sea level pressure), TD (dew point 
temperature at ground level), and TC (temperature at ground level).  Variables 
that are calculated in NCL can be added to a VAPOR VDC using methods 
described in the VAPOR/WRF Data and Image Preparation Guide.  

 
3.1  Selecting and displaying a two-dimensional variable. 

 
We shall show how to combine the SLP and TC variables with the 

isosurfaces and volume rendering created in sections 1 and 2.  We continue with 
the session settings from section 2.3.  If you are resuming at this point, then load 
the session file “wrfFigure2.7.vss”, load the april_lowres dataset, then load and 
enable the terrain image as in section 1.3.  Make sure that the animation panel is 
set to display time step 50, and the Iso renderer is disabled.  

Click on the “2D” tab.  In the variable selection box, identified by the text 
“Select 2D variable(s) mapped to color and transparency”, you will see a list of 
2D variables that are in this dataset.  Scroll down to see the “SLP” variable name 
and select it by clicking with the left mouse button.  Then enable the 2D visualizer 
by checking “Instance: 1” at the top of the 2D panel.  The 2D image in the scene 
may not be immediately visible because by default it is a square in the center of 
the data.  Click the eye icon at the top right of the vapor window (above the 
visualizer) to see the full scene.  You should see the following in VAPOR: 

http://www.mmm.ucar.edu/wrf/OnLineTutorial/Graphics/NCL/index.html
http://www.vapor.ucar.edu/page/wrf-support
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Figure 3.1: Default 2D visualization of SLP 

 
 To provide a more useful visualization of this 2D variable we shall use this 
variable to color the terrain surface, and specify a color map that is more intuitive.  
Below the 2D variable list, check the box labeled “Apply color and opacity to 
terrain surface”.  This will move the 2D image to match the terrain surface 
elevations.   Specify the value 120 as the “Z” coordinate of the Plane/Contour 
Center in the 2D tab.  This will make the 2D surface slightly higher than the 
satellite image in the Image tab.  You should also set the Refinement level to 1, 
so that this surface uses the same refinement level as the terrain image.   
 
Scroll down to the bottom of the 2D tab where a transfer function editor is 
provided.  We shall reverse the colors in this mapping because it is more intuitive 
for large values to be associated with red.  Click on the button labeled “Load 
Installed TF”.  In the file selection dialog that pops up, select the file 
“reversedOpaque.vtf”, and click “Open”.  The resulting transfer function has 
constant full opacity, with the color mapping reversed, so that small values of 
SLP are mapped to blue-violet and large values are mapped to red.  Click on the 
magnifying glass icon at the upper right of the window to zoom into the scene, 
and you will see the following: 
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Figure 3.2: SLP values mapped to terrain using reversed color map 
 
We can combine this image of SLP with other visualizations that will show 

how sea level pressure evolves relative to QVAPOR and T.  First, grab the slider 
on right side of the transfer function editor on the 2D tab, and pull it about 
halfway down (for an opacity value of 0.5).   

 
Next, click on the Iso tab and enable the isosurface rendering of T.  Click 

on the DVR tab and enable the volume rendering of QVAPOR.  Click on the play 
button in the animation toolbar.  Figure 3.3 below shows this visualization at time 
step 30, with all three rendered variables clearly visible over the terrain image.  
You will see how the advance of cold air is associated with a high pressure (large 
values of SLP), and later the decreased pressure is associated with the 
increased QVAPOR at the end of the sequence. 
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Figure 3.3: Combined 2D rendering of SLP 

with 3D volume rendering of QVAPOR and Isosurface of T at timestep 30. 
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Section 4: Steady flow visualization  

 
4.0 Getting started with flow integration 

 
In this section we shall construct flow visualizations based on the same WRF 
dataset that we used the previous sections.  VAPOR visualizes flow by 
performing a numerical integration of a vector field in a volume of data.  The 
integration starts at user-specified starting points, called “seed points”, and tracks 
the successive positions in the volume that result from the integration.  The 
successive positions can be visualized with various geometric entities. 
 

We can continue from the session we established in section 2.2.  If you 
are starting at this point, load the session from figure 2.7, reload the 
april_lowres.vdf dataset and enable the satellite image in the Image panel.  
Disable the isosurface renderer and the DVR, and set the current timestep in the 
Animation tab to 0.  
 

4.1 Constructing random streamlines in the wind field 
 
Click on the Flow tab.  Before we can design an interesting flow visualization, we 
need to establish some basic parameters.  First, we must specify three variables 
that define the vector field that will be visualized.  The wind is defined by the 
three components (U,V,W), so set the X, Y, and Z-coordinate selectors (labeled 
as steady field) to U,V,W.  Note that by default, the flow type is steady.  By 
steady we mean that the vector field does not change during the flow integration.   
The successive positions of a flow line in a steady flow depend only on the 
coordinates along the flow line, not on the elapsed time.  You could also have 
selected the flow Type to be unsteady or Field Line Advection.  One can also 
select whether the flow integration goes forward, backward, or in both directions 
from the seed points.  By default it is set to bidirectional. 

 
 Second, we establish the seed points for the flow, i.e. the points that will 
be used to start the flow integration. Look at the section entitled “Flow seeding 
parameters”.  Note that the seed points are initially set to use a “Random Rake”.  
This means that the seed points are randomly generated within the bounds of the 
box-shaped region defined by the “Rake center” and “Rake sizes”.  Click on the 
button “Set Rake to Current Region”.  (Recall that our current region is a slab at 
the bottom of the data volume.  If a seed point is not inside the current region, 
there will be no flow line generated.)  Set the “seed count” to 50, so that we will 
see 50 flow lines resulting from the random seed points.  This will give us a 
coarse idea of the wind flow, although more accurate seed placement will be 
needed for detailed understanding of the flow.  If you would like to see the 
location of the rake, click on the rake icon at the top of the screen (above the 
tabs) and there will appear a red box with handles describing the location of the 
rake. 
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 Check the “Instance:1” checkbox at the top of the Flow tab, to enable flow 
rendering.  You will see 50 randomly placed thick red tubes passing through the 
volume. 
 
 You probably also saw a warning message indicating that the flow 
variables (U,V,W) are not zero at the bottom of the data.  This can have the 
undesirable effect of causing wind to appear to flow through and below the 
terrain.  To fix this issue, click on Edit→Edit Visualizer Features.  Near the top of 
the Visualizer Features panel is a frame labeled “Variable values outside grid (for 
layered data)”.  This is illustrated in Figure 1.6.  Select the variable “U”, uncheck 
the checkbox labeled “Extend Down”, and specify the value of 0 in the box 
labeled “Below”.  Do the same for the variables “V” and “W”.  Now the wind field 
will be always equal to zero below the terrain.  Click “OK”. 
 
 Returning to the Flow panel, to make the lines thinner, scroll down to the 
“Shape Parameters” section of the Flow tab and set the diameter to 0.15.  Below 
the diameter, set the “Diamond size” parameter to 0.  This controls the size of a 
diamond shape that shows up where the wind velocity is zero.  Your flow lines 
will look as follows: 
 

 
Figure 4.1: Streamlines from 50 random seed points 

 
We can choose how long or short we want the flow lines to be, and how 

smooth they should appear.  Slide the Steady Line Smoothness slider to the right 
to a value of about 200, and set the Typical Steady Flow Length to about 2.  
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These values are based on the average magnitude of the field, and will result in 
flow lines that are of length about 2 times the volume diameter, and having up to 
400 sample points along their length.  
 

The streamlines are by default a constant red color.  To give an indication 
of how strongly the wind is blowing, we can color them according to the wind 
speed.  In the bottom section of the Flow panel, entitled “Color/Opacity mapping”, 
next to the text “Color:”, select “Field Magnitude”.  The mapping from field 
magnitude to color uses the default color mapping at the bottom of the panel, 
mapping the magnitude range (0,59) to the rainbow of colors from red through 
green to purple. 

 
To see how the streamlines vary in time, use the animation toolbar to play 

forward in time.  The same 50 random seed points are repeatedly used to 
produce a changing set of 3D streamlines at each time step.  Note that the wind 
tends to be stronger at higher elevations, and to show much more directional 
variation near the ground. The following shows the streamlines at time step 35.  
Note that the wind direction at this time varies from south-north near the ground 
to east-west at higher elevations, although we cannot yet see which direction the 
wind flows along these curves.  

 

 
Figure 4.2:  Streamlines colored by wind speed at time step 35 

 
It is also interesting to see how the wind direction varies with the changes 

in water vapor.   Click on the DVR tab and enable the QVAPOR rendering (that 
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we created in section 2).  Note as you play the animation how the increase in 
QVAPOR is associated with variation in the streamlines, resulting in more 
significant up/down drafts, and significant changes between lower and upper 
wind direction.   Time step 165 of this animation is illustrated in figure 4.3 below.  
We have accentuated the QVAPOR variable by setting the right mapping bound 
of the DVR transfer function to 0.015. 

 

Figure 4.3:  Increasing wind convection coincides with a moving ridge of 
increased values of QVAPOR. 

 
 Before continuing, save the current session, as we shall need it later.  
Click on File→Save Session As , and save the session under the name 
ConvectiveWind.vss.  Disable the DVR before proceeding. 
 

4.2:  Visualizing and animating wind direction with velocity arrows 
 

We next visualize the wind direction by using regularly placed seed points 
(this is called a Nonrandom Rake).   We shall construct an 8 by 8 array of seed 
points, placed in a rectangle slightly above the ground. Set the time step back to 
0 (using the animation toolbar).  Return to the Flow tab and scroll down to the 
Flow Seeding Parameters.  Select “Nonrandom Rake” (instead of “Random 
Rake”).  At the bottom of the Flow Seeding Parameters, next to “By dimension 
X:…” type in values 8, 8, and 1 into the three textboxes, and press the <enter> 
key.  This will result in a regularly spaced array of seed points, of sizes (in the x, 
y, and z-directions) 8x8x1, centered within the bounds of the current rake (which 
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is also the current region).  Scroll down to the Shape Parameters section.   
Change the Shape (currently set at “Tube”) to “Arrow”.  In the Basic Flow 
Parameters, change the Steady Line Smoothness to 10.  Each streamline is now 
represented by a sequence of arrows pointing in direction of the wind, each 
arrow about 1/10th of the scene diameter.  

 
 In order to position the wind arrows near the ground, click on the rake icon 
button near the upper left corner, above the tabs (unless it is already depressed).  
You will see a red box with handles that indicates the extents of the rake.  Grab 
the top handle of the rake with the right mouse button, and slide it down to where 
the top of the box is about as high as the tops of the mountains at the northern 
end of the scene.  The “z” component of the rake size in the flow tab should be 
about 1000.  The flow arrows are now close to the ground, similar to the 
following: 
 
 

Figure 4.4:  Streamlines represented by arrows shown inside rake box. 
 
 

Next we change the settings to use arrows as a simple indicator of wind 
direction at each seed point, rather than drawing streamlines.  This requires 
disabling the automatic calculation of flow length so that we can use a single 
arrow at each seed point.  In the Basic Flow Parameters, set the Steady 
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Integration Direction to “forward”. In the flow panel, below the Basic Flow 
Parameters, click the button “Show Advanced Flow Parameters”.  Un-check the 
checkbox labeled “Automatically scale steady field”.   Set the Steady samples per 
flow line to the minimum (2), and change the Steady field scale factor to about 
40000.  You will see an 8x8 array of arrows pointing in the wind direction, of 
length proportional to the wind speed, like the following: 

 

Figure 4.5:  Wind vectors at time step 0 
 
To restrict the wind arrows to the horizontal plane, change the third 

component of the steady field from “W” to “0”.  Next we shall combine the flow 
visualization with the DVR and Iso rendering that we prepared before.  Enable 
the DVR of QVAPOR and the Iso renderer of T (these were constructed in 
sections 2 and 4).  To eliminate the rake box, click on the navigation wheel at the 
upper left corner of the window.  Using the animation toolbar, play forward from 
time step 0.  You will note that the wind direction changes abruptly from 
westbound to southbound with the passage of the cold front.  The direction then 
oscillates on a daily basis until the arrival of the moist air from the south.  Figure 
4.6 illustrates the change of wind direction during the passage of the cold front at 
timestep 30: 
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Figure 4.6: Combined visualization of wind arrows 

with QVAPOR and T at time step 30 
 

Next we show how to save this animation sequence as a set of jpeg files, 
so that they can be posted on the Web or combined into an animation sequence. 
Before producing these image files, we shall make a few changes to enhance the 
animation:    
 Click Edit→Edit Visualizer Features to launch the Visualizer Features 
Panel as in figure 1.6.  Next to Time Annotation, select “Date/time stamp”, so that 
the date and time will be displayed in each frame.   Then click OK.   From the 
animation toolbar, set the current time step to 0.  From the main menu, click 
“Capture” and then select “Begin Image Capture Sequence in visualizer 0”.  From 
the file selection dialog that pops up, select a directory and a file name where the 
resulting jpeg files will be saved.  Then, from the animation toolbar, play forward 
to the end of the sequence.  After the sequence is complete, from the Capture 
menu, click on “End Image Capture Sequence in Visualizer 0”.  You will see that 
a series of jpeg files has been saved.  These may be converted to Quicktime® or 
Window Media Player® files using software that you can purchase or obtain from 
the Web.  
 

Note:  When an image capture sequence is very time-consuming, you 
may find it necessary to disable the screen saver on your computer, because the 
screen saver could interfere with the image capturing. 
     

Next, we show how to position the wind arrows to visualize the local flow 
near Atlanta.  Retain the flow settings from above, including the use of the 
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nonrandom rake, with single arrows at each seed point as established by the 
settings we made in the Advanced Steady Flow Parameters. 

 
It will be easiest if we first use the Probe to make Atlanta the center of our 

viewpoint. Disable the Iso, the Flow, and the DVR renderers.  Click on the bold 
upward-pointing arrow near the upper-left corner of the VAPOR window (its 
tooltip is “Data Probe Mode”).  Zoom out of the scene (drag downward with the 
right mouse in the scene) until you see a red rectangle with red handles above 
the middle of Georgia; or click on the eye icon above the visualizer window to 
see the full volume with the probe in the middle of it .  Grabbing the top handle of 
the probe manipulator with the left mouse, slide the probe down near the ground, 
and then, using the handles on the edges of the Probe, center it near Atlanta (the 
white spot on the terrain).  To position the Probe near Atlanta you may find it 
necessary to zoom in and rotate the scene as you reposition the Probe, until you 
get it where you want it.  When the Probe is centered slightly over Atlanta, then, 
on the Probe tab, scroll down below the “Cross-Section View” portion and click 
the button labeled “Use selected point to center: View”.  This button is located 
below the Cross-Section View in the Probe tab.  This will make the cross-hairs of 
the probe become the center of your view.  After you zoom in close to Atlanta, 
your view should look like the following: 
 

 
Figure 4.7:  Probe centered at Atlanta 

 
Now that the view is centered on Atlanta, we can easily position the flow 

rake near Atlanta.  On the probe panel click the button “Use selected point to 
center:... Rake”.  Then, from the Flow panel, adjust the rake size, using the 
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sliders in the Flow Seeding Parameters.  Adjust the X and Y size to about 
100000 (100 km) and adjust the Z size to about 100m.  Also reduce the “Seed 
Count by Dimension” values to 3x3x1.  In the Advanced Steady Flow 
Parameters, reduce the Steady field scale factor to 20000, to make the arrows 
half as long. 
 

Enable the Flow, to display the wind arrows. Enable the volume rendering 
of QVAPOR to see how the wind in Atlanta changes as the front passes through. 
Figure 4.8 illustrates the wind arrows near Atlanta at time step 12, just as the 
cold front is passing. 
 

 
Figure 4.8: Wind vectors near Atlanta at time step 12 with volume render of 

QVAPOR 
 

Save the current session as “AtlantaArrows.vss” before continuing.  We shall 
return to this session in a later section.  

 
4.3: Using the Probe to visualize wind near the mountains 
 
In this section we use the Probe tool to visualize the wind patterns that 

occur near the mountains north of Atlanta.  The Probe combines a number of 
useful functions.  For example, as we saw in section 4.2, the Probe is useful for 
obtaining precise coordinates for specific features in the visualization and for 
repositioning the viewpoint and the rake.  The Probe can also be used to create 
planar contour plots of any 3D variable in the scene.  The Probe has two other 
important capabilities for investigating flow fields.  In this section we shall first use 
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the Probe to create animated images of flow motion, to get a better sense of how 
the mountains affect the flow.  We shall then use the probe to insert flow seeds 
using the images in the probe for spatial reference. 

 
To return to the visualization of section 4.1, from the File menu, load the 

session file we saved at the end of section 4.1 (ConvectiveWind.vss) or, if you 
did not save that session, you can load the file WRFFigure4.3.vss from the vapor 
examples directory.  From the Data menu, load the april_lowres.vdf.  Load and 
enable the satellite image from the Image panel.  Enable the flow by checking the 
“Instance: 1” checkbox. 

 
We next position the probe above the mountains north of Georgia where 

the wind flow patterns are affected by the mountains.  Set the time step (in the 
animation toolbar) to 150.  Rotate the scene around (dragging with the left mouse 
button) so that you are looking southward from a position north of Georgia.  You 
will note that a few of the streamlines are following the terrain over the 
mountains, as in the following: 

 

  
Figure 4.9:  Streamlines over the mountains north of Georgia at time step 150 

 
Click on the probe (upward pointing thick arrow) icon above the tabs near 

the top of the VAPOR window, if that button is not already pressed.  Zoom out, 
by dragging downward in the scene with the right mouse button, until you see the 
probe outline.  By clicking and dragging with the left mouse button on the red 
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handles on the probe, slide it to the north end of the scene right above the 
mountains.   

 
In the Probe tab, check the “Instance: 1” checkbox to enable the first 

probe instance, and set the Refinement level to 1.  Then scroll down to the 
bottom of the Probe tab, and, above the Transfer Function Editor, select the 
Mapped Variable “W”.  You will see a coarse image of the W variable in the 
probe in the scene, similar to the following: 

 

 
Figure 4.10: Probe of W in wind flow near mountains 

 
 In order to be consistent between the various renderers in the scene, set 

the refinement level in the Flow panel to 1, and, in the Image panel, set the 
refinement level of the terrain image to 1. 

 
We would like the probe to be vertically oriented so as to see the vertical 

wind motion.  In the probe tab, at the bottom of the top section entitled “Probe 
Position and Size” there is a selector displaying the text “90 degree rotate”.  
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These controls can be seen in Figure 4.11 below. From that rotation selector, 
choose “+X” to rotate the probe 90 degrees about the positive X axis.  You will 
see that the probe is now very tall (the scene vertical stretch causes this effect). 
Then click the button “Crop to Region”, below the rotation selector, to make it 
shorter.  You will note that the image of the probe in the probe tab is as seen 
from the south side.  Rotate it 180 degrees about the vertical axis by twice 
choosing “+Z” from the rotation selector.  To facilitate navigating around the 
probe, click the button (below the probe image) labeled “Use selected point to 
center: View”, making the probe center the center of your view. 

At the top of the probe tab, under the text “Probe Type” select “Flow 
Image”.   In the section of the Probe entitled “Flow Image Control” set the steady 
field variables to U, V, and W. The image in the probe will become a black-and-
white representation of flowing particles as in the following: 

 

 
Figure 4.11: Flow Image over the mountains 

 
Note that in figure 4.11 the probe in the scene intersects the terrain, so 

that lower portions of the probe in the tab are black.  Also, the aspect ratio of the 
probe in the tab is adjusted to make the pixels in that image square.  This can 
make the probe in the scene appear stretched relative to the probe in the tab.  
The flow image in the probe is best understood by animating it.  In the “Flow 
Image Control” section of the Probe Tab, above the Cross Section View, click on 
the play (►) button, so see the flow motion represented as moving particles.  
You will see that the wind is flowing over the mountains from west to east. This is 
a flow visualization technique known as “Image Based Flow Visualization” or 
IBFV, invented by Jarke Van Wijk (Proc. Siggraph 2002). Basically it works by 
advecting a noise pattern in the flow, and blending in the result of multiple 
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advections over time.  The flow motion is projected into the plane of the probe. 
You can tune the flow images by tweaking the Scale and Alpha sliders in the 
Flow Image Control, and the flow images can be captured as a sequence of jpeg 
files by pressing the “Start Image Capture” button. 

To better visualize the flow over the mountains, increase the width of the 
probe to about 350km (e.g use the Probe/Contour Xp Size slider in the probe 
tab).  Then use the Z: thumbwheel (under the text “Rotate about axes” to orient 
the probe to go from north-west to south-east.  Move your viewpoint and 
reposition the probe to where you have a good view of the wind over the 
mountains as in the following: 

 

 
Figure 4.12: IBFV of wind flow over the mountains 

 
In the above image, the probe is centered at X = 440000, Y = 890000, and 

is oriented with theta = 45 degrees.  
Next we use the probe to position flow seed points.  In the flow panel, 

under Flow Seeding Parameters, select “List of Seeds” replacing “Random 
Rake”.  Dismiss the error messages about the lack of seeds at the current time 
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step. You will notice that the streamlines have disappeared because there are no 
seeds in the current seed list.  Select the probe tab and scroll down where you 
can see the options below the Cross-Section View.  Check the check box entitled 
“Attach Point to Flow Seed”.  You will see a streamline originating at the position 
of the cross-hairs in the probe.  By moving the cursor around the probe image 
you can position flow seeds and see the resulting streamlines.  Each time you 
find a streamline of interest, click the button “Add Point to Flow Seeds”.  Repeat 
this until you have added enough seeds to get an understanding of the wind flow 
in this region.   

At the bottom of the flow panel in the section “Color/Opacity mapping”, 
select the color mapping to be “Position along Flow”, so that streamline color 
indicates the wind direction, going from red to violet as in the following: 

 

 
Figure 4.13:  Streamlines inserted in the flow by selecting seed points  

in the IBFV image in the Probe 
 

Observe that at higher elevations the wind flows over the mountains from 
west to east; however, nearer the terrain, streamlines may be trapped in the 
valleys and sometimes emerge from the mountains in a southerly direction.
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Section 5: Unsteady Flow Visualization (particle trajectories) 
 
Unsteady flow visualization can be used to track the motion of wind currents over 
time, or to see particle trajectories.  As in Section 4, specifying the flow requires 
establishing a set of seed points; however, with unsteady flow, the seed points at 
one time step determine the flow positions at subsequent time steps.  Each seed 
point is moved by integrating the flow field for one time step, resulting in a new 
point at the next time step. 
 

In this section we use the rake as well as the Probe tool to specify seeds, 
providing a precise way of controlling the seed point placement. 
 

5.1 Tracking the motion of particles released near Atlanta 
  
 We continue with the setup used for figure 4.8 at the end of section 4.2.  
(Load the session “AtlantaArrows.vss” or WrfFigure.4.8.vss , load the 
april_lowres.vdf data, and load and enable the satellite image in the Image 
panel.).  Set the current time step to 12.  Click on the Flow tab, and set the Type 
to “Unsteady”.  Set the unsteady field variables to U, V, and W. Set the Unsteady 
Integration Direction to “Forward”.  (Note: the Unsteady field scale factor should 
be set to “1”, since the correct scaling factors were derived from the WRF output 
files when the Vapor data was constructed.)  Then enable the flow.  It will take 
few seconds to integrate the flow, because U, V, and W for all 180 time steps 
need to be read from disk.  

When the integration is complete, you will see that the 9 seed points have 
resulted in 9 path lines, describing the trajectories that would be taken by 9 
particles released near Atlanta at time step 0.  To animate the motion of these 
particles, scroll down (in the Flow panel) to the “timestep display interval min, 
max” values at the bottom of the Shape Parameters.   Set these values to -3 and 
3.  This means that at each time step t you will see the sequence of particle 
positions from time steps t-3 to t+3.  You can animate this motion by clicking on 
the play button in the animation toolbar.   
 

To see the continuing motion of particles that are repeatedly released near 
Atlanta, set the “Seed time start, end, increment” values at the bottom of the Flow 
Seeding parameters.  These specify the first and last time step that seeds are 
released, and the increment between subsequent seed release times.  Set these 
to 0, 170, and 10, so that seed particles will be released every 10 hours.  This 
setup is useful for tracking the motion of pollutants released at Atlanta.  You will 
note that the particle paths generally stay close to the ground until they reach the 
ocean.  The following image illustrates these paths at time step 75, showing that 
particles released at times 70, 60, and 50 are near the ground, while the seed 
particles released at time step 40 have reached the ocean and are moving 
upward: 
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Figure 5.1:  Particles released at Atlanta reaching the ocean at time step 75 

 
5.2:  Placing flow seeds with the Probe 

 
In order to see the motion of particles released in the mountains north of Atlanta, 
we place individual seed points manually, using the Probe.  Continuing with the 
setup from Figure 5.1, disable the Flow, and click on the probe arrow near the 
upper left-hand corner of the VAPOR window.  The probe should still be 
positioned near Atlanta; if not, follow the directions in section 4.2, preceding 
figure 4.7, to position the probe.  In the lower part (“Appearance Parameters” 
section) of the Probe panel is a “Mapped Variables” selection box.  Hold the “Ctrl” 
key while you select the three variables U, V, and W.  (Multiple variable selection 
results in the norm of the vector of the variables being color-mapped in the 
probe.) This will enable us to see the magnitude of the wind velocity in the cross-
section image in the probe.  Set the current time step to 0.   
 
 Now check the “Instance: 1” checkbox to enable the probe.  You will see a 
horizontal rectangle near Atlanta, colored according to the wind velocity.  It is 
fairly coarse because we are using the lowest resolution data.  Set the 
Refinement level of the Probe to 1 to see a more accurate indication of wind 
speed in the Probe.   
 

In the Probe panel there is a Transfer Function Editor like the one in the 
DVR panel.  This one is controlling the mapping from wind velocity to color and 
opacity.  In order to map larger values of velocity to red, click on the button “Load 
Installed TF” and select the transfer function “reversedOpaque.vtf”.  Set the TF 
Domain Bounds to 0.01 and 10 and press “enter”. (We set the minimum larger 
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than 0 so as to avoid zeroes contributing to the histogram.)  Then click “Fit to 
View” and “Histo” to see a histogram of the values of the wind speed in the 
probe.  This is illustrated in Figure 5.2: 

 

 
Figure 5.2:  Data probe above Atlanta at time step 0. 

 
Note that the portion of the probe below the ground is colored violet; this is 

because U, V, and W were set to be 0 below the lowest level of the WRF grid in 
section 4.1, and the probe color mapping assigns the color violet to the value 0. 
 
  

We must orient the probe vertically to see a cross-section of wind speed 
near the ground level.  Note that the Probe Orientation Angles are currently set to 
zero, indicating that the (x,y,z) coordinates in the probe are along the same axes 
as in the scene.  The probe orientation controls are shown in figure 4.11. Below 
the Orientation Angles there is a selector with the text “90 deg rotate”, which 
provides a convenient way of rotating the probe by 90 degrees.  Click on the 
selector, and select “- Y” to rotate the probe so it points up and down.  Then 
select “+ X” from the same selector so that the bottom of the probe image is 
downward in the scene. (Note: phi is the rotation of the probe from the vertical (z) 
axis, theta is a rotation about the z-axis, and psi specifies a rotation of the probe 
about its center axis prior to its insertion in the scene.  You could rotate the probe 
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by setting these angles, but it‟s easier to use the rotation selector.)  Click on the 
“Crop to Region” button to shorten the probe. Navigate in the scene so that you 
are looking eastward at the probe from the west side.  Grab the top handle of the 
probe with the right mouse button and drag it down to make the probe image 
approximately square, as in the following image: 

 

 
Figure 5.3:  Vertically oriented probe above Atlanta. 

 
 To position the probe further north and east of Atlanta, first re-center the 
view on the probe by clicking the button on the probe tab, below the Cross 
Section View, labeled: “Use selected point to center: View”.  Then drag the 
handles on the probe with the left mouse button to position the probe in the 
mountain range north-east of Atlanta.  (You can alternatively just set the probe 
center coordinates at about (578000, 900000, 1000). Navigate your viewpoint 
around to the east side of the probe, as in the following: 
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Figure 5.4:  Probe placed in mountains northeast of Atlanta 

 
We next use the probe to specify a set of flow seed points near the 

mountains.  Click on the Flow tab.  In the Flow panel, in the Flow Seeding 
Parameters, select “List of Seeds” instead of “Nonrandom Rake”.  In the flow 
Shape Parameters, set the “timestep display interval min, max” to -100 and 100 
With this setting we shall see 100 time steps of the path lines, forward and 
backward, relative to the current time step resulting from the seed points we 
insert.  Check the “Instance:1” checkbox to enable the flow integration.  Since no 
seeds have been specified, you will not see any flow lines.  Click on the Probe 
tab, and check the check-box “Attach Point to Flow Seed” which is located below 
the Cross-Section View.  You will need to dismiss a couple of warning popup 
messages, indicating that all the flow lines have exited the current region.  You 
will see be a series of flow arrows that start at the position of the cursor and 
move to the east from the probe.  Zoom out, to get a good view of the path line 
as in the following: 
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Figure 5.5:  Trajectory (path line) resulting from seed point in the probe. 

 
Using the left mouse button, click at various positions in the cross-section image 
in the Probe tab.  You will see the resulting path lines.  If the point you pick is 
under the ground, the path will go nowhere.  Note that some of the path lines 
appear to intersect the ground.  This is because, in order to save data access 
time, the flow integration is using Refinement level 0 of the wind field; however 
the probe and the terrain rendering we are using are at Refinement level 1.  More 
accuracy could be obtained by using the full accuracy (refinement level 2) of the 
original data.   
 
Select a few seed points near the terrain surface.  Each time you find a seed 
point of interest, click on the button “Add point to flow seeds”.  After you have 
added 8-10 seeds, you can clearly see how the particles follow the terrain to the 
east of the probe, as in the following:  
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Figure 5.6: Trajectories (i.e. path lines) of particles released near the mountains. 
 

To animate these particle trajectories, it is useful to set up the flow settings 
similar to the previous settings of unsteady flow near Atlanta.  Rather than just 
having the particles released at one time step, we would like to see the result of 
releasing particles every 10 time steps.  Disable the Probe and the Flow tabs.  In 
the Flow tab, in the section entitled “Shape Parameters”, set the “timestep 
display interval min, max” to -3 and +3.  In the Flow Seeding Parameters click on 
the button “Edit Seed List”.  You will see that all of the flow seed points are set to 
have time step 0.  For each seed point in the list, double-click in the time step 
cell, and replace the 0 with an asterisk “*”, indicating that the seed can be 
inserted at any time step.  Make sure that the Seed time start, end, increment (at 
the bottom of the Flow Seeding Parameters) are still set to 0, 170, 10.  Click OK 
to accept the new values in the list. 
 

Now enable the flow rendering.  From the animation toolbar, play forward.  
You will see the paths followed by particles placed every 10 time steps near the 
mountains.  The following shows this animation at time step 30: 
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Figure 5.7:  Trajectories of particles emitted every ten hours from the probe 

positioned in the mountains, viewed at time step 30. 
 
A full animation of this sequence, calculated at full resolution and including 
rendering of T and QVAPOR, can be viewed at: 
http://www.vapor.ucar.edu/sites/default/files/gallery/movies/unsteadyAnim.mov 
 

 Appendix:  How VAPOR deals with WRF data 
 
(The following section is for people who wonder about how VAPOR deals with 
WRF data grids.  You can bypass this section on first reading.)  WRF datasets 
contain a number of variables defined on a non-Cartesian 3D grid.  VAPOR uses 
the 3D variables defined above the ground (i.e., it ignores soil_layers), and it also 
uses the floating point 2D variables that are oriented horizontally. The grid is 
regularly spaced in X and Y, but the vertical (Z) dimension can be nonuniform.   
 
      When a WRF dataset is converted to a VAPOR VDC (see the 
VAPOR/WRF Data and Image Preparation Guide), these 3D and 2D variables in 
the WRF dataset are saved in the VAPOR data format in wavelet form.  This 
format does not increase the size of the data but does enable rapid access to 
sub regions or lower resolution versions of the data.  Included in the VAPOR data 
is an additional variable called “ELEVATION” which is equal to (PHB+PH)/g, i.e. 

http://www.vapor.ucar.edu/sites/default/files/gallery/movies/unsteadyAnim.mov
http://www.vapor.ucar.edu/page/wrf-support
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is equal to the elevation above sea level at each point in the WRF grid.  At 
conversion time, additional derived variables, such as normalized pressure, can 
optionally be calculated.  
 

At visualization time, when a VAPOR user first accesses a variable in the 
data, the wavelet coefficients are converted to Cartesian gridded data in a two-
step process:  First a wavelet reconstruction of the WRF-gridded region is 
performed, then that data is interpolated to the Cartesian grid, utilizing the 
ELEVATION data to define the interpolation.  The vertical spacing of the 
Cartesian grid is determined by the value of “Full Vertical (Z) Grid Height” 
specified in the Region panel. The reconstruction and interpolation results are 
cached to minimize data read time. 
 
 The variables in a WRF dataset may be specified in the WRF grid on cell 
centers or on face centers (i.e. on an unstaggered or staggered grid).  VAPOR 
uses only the cell-centered grid, so all variables on unstaggered grids are 
averaged to the cell-centered grid when the data is converted. 
 
 The vertical resolution of the Cartesian grid that is used for visualization is 
controlled by the VAPOR user (in the Region tab).  By default, the full resolution 
grid has height equal to four times the number of vertical layers in the WRF grid.  
A higher vertical resolution is appropriate when examining regions, such as near 
the terrain surface, where the WRF layers are more closely spaced.  When users 
visualize low resolution versions of the data (by specifying a refinement level in a 
visualizer), the vertical resolution is reduced by the same power-of-two factor as 
is the horizontal resolution. 
 

When constructed using VAPOR data conversion utilities, the default 
VAPOR grid extends vertically from the bottom of the lowest layer of the WRF 
grid to the bottom of the highest layer of the WRF grid.  (These extents are 
calculated by averaging (PHB + PH)/g, since PH and PHB are specified on a 
vertically staggered grid).   As a result there can be points in the VAPOR grid that 
are outside (below or above) the WRF grid.   By default, all variables in the data 
have their bottom and top values extended from the bottom and top of the 
VAPOR Cartesian grid; however users can specify any other value for these in 
the Visualizer Features panel.  Different vertical extents for the grid can also be 
specified by the wrfvdfcreate utility. 
 
 Typical WRF grids extend much further in the horizontal dimensions than 
in the vertical.  A WRF grid may have a horizontal size of thousands of 
kilometers, while the vertical dimension is often on the order of a kilometer.  
When visualizing such 3D data in its native scale, users would not be able to see 
vertical features of the data.  VAPOR allows the users to stretch the data (using 
the Visualizer Features panel), exaggerating the vertical scale.  This stretching 
only affects how the data appears to the user; it does not modify the data values 
or affect the flow integration. 
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 The bottom level of the data can be displayed in VAPOR as a terrain 
surface (using the HGT variable to specify terrain elevation), and users may 
supply an image (as a tiff image specified in the Image panel) that will be applied 
to that surface.  Two-dimensional variables can also be mapped to the  terrain. 
Note that the terrain surface will not always coincide precisely with the lowest 
values of variables in the data, due to user-specified approximations used in 
displaying the data.  To obtain the closest match to the terrain surface, the 
variables and the terrain must be visualized at highest resolution, and the vertical 
grid height must be great enough to ensure the vertical grid spacing is finer than 
the vertical spacing at the lowest level of the WRF grid. 
 


